NI 447X Calibration Procedure

This document contains information about calibrating National
Instruments PCI/PXI-447X devices.

This document does not discuss programming techniques or compiler
configuration. The National Instruments DAQmzx driver includes help files
that have compiler-specific instructions and detailed function explanations.
You can install these help files when you install NI-DAQmx on the
calibration computer.
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Conventions

The following conventions appear in this document:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.
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This icon denotes a note, which alerts you to important information.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names and hardware labels.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Monospace text denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

NI 447X refers to the NI PCI/PXI-4472 and NI PCI/PXI-4474 unless
otherwise noted.

The integer variable type used in this document is represented as a whole
number. Any floating point variable type is represented as a number with a
decimal point. For example, the number 1,024 is written as 1024 if it is an
integer, and as 1024 . 0 if it is a floating point value.

A parameter which points to data that is modified by a function call has a
variable name in the form <variableTypeReturnValue>, for example,
uInt32PointerReturnvalue. All function calls return a status integer
that you must verify. Because all the functions return this status integer, the
function descriptions in this document omit the status integer.

NI 447X Calibration Procedure

Calibration requires the latest NI-DAQmx driver. NI-DAQmx includes
high-level function calls to simplify the task of writing software to calibrate

devices. The driver supports many programming languages, including
LabVIEW, LabWindows™/CVI™, C/C++, C#, and Visual Basic .NET.

If you want to write the calibration procedure using LabVIEW, NI
recommends that you use the Full or Professional Development System
or the Developer Suite Professional Edition. These editions include
frequency-domain analysis tools not included in the Base Development
System.
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Documentation

If you are using the NI-DAQmx driver, the following documents are your
primary references for writing your calibration utility:

*  The NI-DAQmx C Reference Help includes information about the
functions in the driver.

*  The DAQ Getting Started Guide for NI-DAQ 8.0 or later provides
instructions for installing and configuring NI-DAQ devices.

*  The NI-DAQmx Help includes information about creating applications
that use the NI-DAQmx driver.

* NI 447X Specifications contains information about specific device
features. The limits you use to verify the accuracy of the devices are
based on the specifications found in this document.

These documents are installed with NI-DAQmx. You can also download
the latest versions from the NI Web site at ni . com/manuals.

Calibration Interval

Password

NI 447X devices should be externally calibrated at a regular interval as
defined by the measurement accuracy requirements of your application.
NI recommends that you perform a complete calibration at least once every
year. Based on your measurement accuracy needs, you can shorten this
interval to 90 days or six months. Self-calibration can be performed as
needed or when the temperature varies by 5 °C or more from the last
external calibration.

The default password for password-protected operations is NI.

Getting Calibration Information

The NI 447X devices contain the following calibration information stored
in the EEPROM:

*  Whether the device supports self-calibration
e Date and time of the last self-calibration
e Recommended interval for external calibration

e Date and time of the last external calibration
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You can access this information in the Measurement & Automation
Explorer (MAX) or by using the following LabVIEW VIs.

@ Note Refer to the NI-DAQmzx function parameters for the LabVIEW input values.

LabVIEW Block Diagram
(o & W] =% DM Calibration Infa o el al sunnorted
Ackiveley J—
fckiveD celfcal.s ked [ S
- e E. EelfCal LastDate) Time|
I/1 SelfCal, LastDate) Time s
ExtCal.RecommendedInteryal ¥ A
ExtCal LastDate/ Time ¥ E:tCal. RecommendedInterval|
E:tCal.LastDate) Time|

b

NI-DAQmx Function Call

Call DAQmxGetSel fCalSupported with the following parameters:
deviceName: dev1l

data: bool32PointerReturnvalue

Call DAQmxGetSel fCallLastDateAndTime with the following parameters:
deviceName: devl

year: uInt32PointerReturnvalue

month: uInt32PointerReturnvalue

day: uInt32PointerReturnvalue

hour: uInt32PointerReturnvalue

minute: uInt32PointerReturnvalue

Call DAQmxGetExtCalRecommendedInterval with the following parameters:
deviceName: devl

data: uInt32PointerReturnvalue
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Call DAQmxGetExtCalLastDateAndTime with the following parameters:

deviceName: dev1l

year: uInt32PointerReturnvValue
month: uInt32PointerReturnvalue
day: uInt32PointerReturnvalue
hour: uInt32PointerReturnvalue

minute: uInt32PointerReturnvalue

Call DAQmxGetExtCalLastTemp with the following parameters:

deviceName: devl

data: float64PointerReturnvalue

Call DAQmxGetCalDevTemp with the following parameters:

deviceName: devl

data: float64PointerReturnvalue

Test Equipment

Table 1 lists the instruments NI recommends for calibrating the NI 447X.

Table 1. NI 447X Calibration Equipment Specifications

Instrument

Critical Specifications Suggested Model

Calibrator

Frequency Range: 20 Hz—45 kHz Fluke 5700A
Voltage Range: up to 5 V

AC Accuracy: £0.1%", 20 Hz-95 kHz
DC Accuracy: 115 ppm* at 5V

Function Generator

Frequency Range: up to 10 kHz HP/Agilent 33250A

Frequency Accuracy: =2 ppm?

Voltage Range: up to 9 V,,,

€1Tor1.

* AC accuracy is the sum of all errors, including percent of reading error and temperature error but excluding percent of range

TFrequency accuracy is the sum of all errors, including initial accuracy and stability errors.

If the recommended instrument is not available, select a substitute
calibration standard that meets the given specifications.

© National Instruments Corporation 5 NI 447X Calibration Procedure



Test Conditions

Follow these guidelines to optimize the connections and the environment
during verification and adjustment:

Keep connections to the NI 447X short. Long cables and wires act as
antennae, picking up extra noise that can affect measurements.

Use SMB coaxial cable for all connections to the device.

Keep relative humidity between 10 and 80%, noncondensing, or
consult the device documentation for the optimum relative humidity.

Maintain the temperature between 18 and 28 °C, or refer to the device
specifications for the optimum temperature range.

Allow a warm-up time of at least 15 minutes to ensure that the
measurement circuitry of the NI 447X is at a stable operating
temperature.

Allow a warm-up time for all the instruments and equipment,
according to the manufacturers’ instructions.

Calibration Procedure

This section provides instructions for verifying and calibrating the NI 447X
device.

The calibration procedure consists of the following steps:

L.
2.

Initial Setup—Configure the device in NI-DAQmx.

Self-Calibration—Measure the onboard reference voltage of the
device and adjust the self-calibration constants.

NI 447X Verification Procedure—Verify the accuracy of the device
prior to calibration.

NI 447X Adjustment Procedure—Perform an external calibration that
adjusts the device calibration constants with respect to known voltage
sources.

Perform another verification to ensure that the device operates with the
specifications after adjustment.

The initial setup, self-calibration, verification, and adjustment procedures
are explained in the following sections.

@ Note You must compare the verification limits provided in this procedure with the most
recent specifications. Refer to the latest NI 447X Specifications document at ni . com/

manuals.

NI 447X Calibration Procedure
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Initial Setup

NI-DAQmx automatically detects all NI 447X devices. However, for the
driver to communicate with the device, you must configure the device in
NI-DAQmx.

Complete the following steps to configure a device in NI-DAQmx:
1. Install the NI-DAQmx driver software.

2. Power off the computer that will hold the device and install the device
in an available slot.

Power on the computer and launch MAX.

4. Right-click the device name and select Self-Test to ensure that the
device is working properly.

@ Note When a device is configured with MAX, it is assigned a device name. Each function
call uses this device name to determine which DAQ device to calibrate. This document
uses devl to refer to the device name. In the following procedures, use the device name as
it appears in MAX.

Self-Calibration

Call self-calibration before completing the first verification. The DAQmx
Self Calibrate VI, as shown below, measures the onboard reference voltage
of the device and adjusts the self-calibration constants to account for any
errors caused by short-term fluctuations in the operating environment.
When you self-calibrate a device, no external signal connections are
necessary.

@ Note Refer to the NI-DAQmx function parameters for the LabVIEW input values.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxSelfCal with the following
parameters:

Error ouk

deviceName: dev1

Verification Procedure

Verification determines how well the NI 447X device is meeting
specifications. By completing this procedure, you can see how the device
has drifted over time, which helps you determine the appropriate
calibration interval for your application.
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Analog Input Performance Verification

This section verifies the analog input (AI) performance of all NI 447X
devices. Refer to the NI 447X Specifications for the number of channels and
performance specifications.

Al DC Offset Verification
Complete the following steps to verify the AI DC offset:

1. Connect a BNC shorting cap to the analog input channel O of the
device. The terminator grounds the input channel because it is in
pseudodifferential configuration.

2. Ifyouuse LabVIEW, skip this step. If you use C function calls, create
a task using DAQmxCreateTask, as shown below. The task is created

in step 3 in LabVIEW.

LabVIEW Block Diagram

NI-DAQmx Function Call

LabVIEW does not require this step.

Call DAQmxCreateTask with the following parameter:

taskHandle: mytaskHandleReturnvValue

You use the object myTaskHandle in all subsequent NI-DAQmx
function calls.

3. Create an Al voltage channel through NI-DAQmx using the DAQmx
Create Virtual Channel VI, as shown below.

@ Note Refer to the NI-DAQmx function parameters for the LabVIEW input values.

LabVIEW Block Diagram

NI-DAQmx Function Call

put: berminal configuration]

=

oz
"I

+—F
Jnn

kask ouk
/0

Error ouk

Al Vaolkage * —

@

Call DAQmxCreateAIVoltageChan with the
following parameters:

taskHandle: myTaskHandle
physicalChannel: devl/ai0
nameToAssignToChannel: " "
terminalConfig: DAQmx_val_PseudoDiff
minVal: -10.0

maxVal: 10.0

units: DAQmx_Val Volts

CustomScaleName: NULL

NI 447X Calibration Procedure
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4. Modify the Al voltage channel properties using the following
functions.

LabVIEW Block Diagram

NI-DAQmx Function Call

"1 == Dagmx Channel §

kask.

/0

Call DAQmxSetAIGain with the
following parameters:

taskHandle: myTaskHandle

channel: dev1/ai0

data: 0.0

¥ Al.Gain E Error ouk|
G &1 Coupling

Call DAQmxSetAICoupling with the
following parameters:

taskHandle: myTaskHandle
channel: dev1/aio0

data: DAQmx_vVal_DC

5. Configure the timing properties of the acquisition using the DAQmx
Timing VI, as shown below.
LabVIEW Block Diagram NI-DAQmx Function Call
Call DAQmxCfgSampClkTiming with
Earples per channel the following parameters:
G2 &P '
I — taskHandle: myTaskHandle
[EEZT, bask out] | source: NULL
- I

rate: 102400.0

170 Errar aukt

e sample Clock v[| s activeEdge: DAQmx_vVal_Rising

DEL K sampleMode:

DAQmx_Val_FiniteSamps

sampsPerChanToAcquire: 51200

Error ouk

H

6. Start the task using the DAQmx Start Task VI, as shown below.
LabVIEW Block Diagram NI-DAQmx Function Call
- Call DAQmxStartTask with the following
ask.in kask ouk .
parameters:
] 170
= taskHandle: myTaskHandle

© National Instruments Corporation
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7. Acquire data using the DAQmx Read VI, as shown below.

LabVIEW Block Diagram NI-DAQmzx Function Call

Call DAQmxReadAnalogF64 with the
following parameters:

taskHandle: myTaskHandle

= taISJLDLIt numSampsPerChan: -1
timeout: 10.0
umber of samples per channel] | fillMode:
: ﬁ%%,: DAQmx_Val_GroupByChannel
_ : = Lﬂerrur ouk
Analog 10 DEL _ arraySizeInSamps: 51200
1Chan N3amp

reserved: NULL

readArray:
float64ArrayReturnValue

sampsPerChanRead:

int32PointerReturnValue

8.  Stop the task using the DAQmx Stop Task VI, as shown below.

LabVIEW Block Diagram NI-DAQmx Function Call
- Call DAQmxStopTask with the following
Lask out parameters:

70 70
. ._[m Error ot taskHandle: myTaskHandle

9. Clear the task using the DAQmx Clear Task VI, as shown below.

H

LabVIEW Block Diagram NI-DAQmzx Function Call
Call bAQmxClearTask with the following
parameters:
?.;:__?,:_lDUt taskHandle: myTaskHandle

NI 447X Calibration Procedure 10 ni.com




10. Average all the values in the array returned from the acquisition. The

average is the resulting offset for AI 0. Compare this value to the limits
in Table 2.

Table 2. Al Offset Limits

Device Input Offset

Min (mV) Max (mV)

-3.0 3.0

11.

Repeat steps 1 through 10 for all remaining analog input channels of
the device. Replace ai0 with the appropriate channel name in function
call parameters physicalChannel and channel.

Al Gain Accuracy Verification

Complete the following steps to verify Al gain accuracy:

1.

Connect the output of the calibrator to the analog input channel O of the
device.

2. Program the calibrator amplitude and frequency as listed in Table 3.
If you use LabVIEW, skip this step. If you use C function calls, create
a task using DAQmxCreateTask, as shown below. The task is created
in step 4 in LabVIEW.
LabVIEW Block Diagram NI-DAQmx Function Call

LabVIEW does not require this step.

Call DAQmxCreateTask with the following parameter:

taskHandle: mytaskHandleReturnvalue

© National Instruments Corporation

You use the object myTaskHandle in all subsequent NI-DAQmx
function calls.
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4. Create an Al voltage channel through NI-DAQmx using the DAQmx
Create Virtual Channel VI, as shown below.

@ Note Refer to the NI-DAQmzx function parameters for the LabVIEW input values.

LabVIEW Block Diagram NI-DAQmzx Function Call

Call DAQOmxCreateAIVoltageChan withthe
following parameters:

nput kerminal configuration]

taskHandle: myTaskHandle

2

inimum value physicalChannel: devl/ai0

nameToAssignToChannel: " "

kask out terminalConfig: DAQmx_val_PseudoDiff

= minVal: -10.0

yli
= Errar ouk Val
- i maxVval: 10.0
ErEOr in Al volkage
[Eat s units: DAQmx_Val Volts

CustomScaleName: NULL

5. Modify the Al voltage channel properties using the following

functions.
LabVIEW Block Diagram NI-DAQmzx Function Call
Call DAQmxSetAIGain with the
following parameters:
ask, taskHandle: myTaskHandle
1 bask

channel: dev1/ai0

/0

o ﬂ-ﬁD.ﬁ.me Channel g

" AL Gain H error out] data: 0.0
b A1, Coupling | Call DAQmxSetAICoupling with the
following parameters:

taskHandle: myTaskHandle

channel: dev1/ai0

data: DAQmx_Val_DC

NI 447X Calibration Procedure 12 ni.com



6. Configure the timing properties of the acquisition using the DAQmx
Timing VI, as shown below.

LabVIEW Block Diagram

NI-DAQmx Function Call

samples per channel

B

rode

Call DAQmxCfgSampClkTiming with the
following parameters:

taskHandle: myTaskHandle
source: NULL

rate: 102400.0

Sample Clock *

-

activeEdge: DAQmx_vVal_Rising
sampleMode: DAQmx_Val_FiniteSamps

sampsPerChanToAcquire: 51200

7. Start the task using the DAQmx Start Task VI, as shown below.

LabVIEW Block Diagram

NI-DAQmx Function Call

ask.in
]

kask ouk

/0

Error out

o

Call DAQmxStartTask with the following
parameters:

taskHandle: myTaskHandle

© National Instruments Corporation
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8. Acquire data using the DAQmx Read VI, as shown below.

LabVIEW Block Diagram

NI-DAQmx Function Call

ask.in
]

kask ouk
70
Fumber of samples per channel] mej_
[I32] &3 I:Ll:l:l:l:l:l:l:l:l:l:l:l ] E
DL
Analog Wm Lerrur ot
1Chan MSamp

[oBLE

Call DAQmxReadAnalogF64 with
the following parameters:

taskHandle: myTaskHandle
numSampsPerChan: -1
timeout: 10.0

fillMode:
DAQmx_Val_GroupByChannel

arraySizeInSamps: 102400
reserved: NULL

readArray:
float64ArrayReturnValue

sampsPerChanRead:

int32PointerReturnValue

9. Stop the task using the DAQmx Stop Task VI, as shown below.

LabVIEW Block Diagram NI-DAQmx Function Call
T——— Call DAQmxStopTask with the following

1.0

0
.{ﬁLﬂ error ook

parameters:

taskHandle: myTaskHandle

10. Clear the task using the DAQmx Clear Task VI, as shown below.

LabVIEW Block Diagram

NI-DAQmx Function Call

Eerror ouk

Call DAQmxClearTask with the following
parameters:

taskHandle: myTaskHandle

NI 447X Calibration Procedure

11. If you use LabVIEW, use the Analog 1D Wfm 1chan Nsamp
polymorphic VI to acquire data in step 8. Measure the RMS value of
the input using the Amplitude and Level Measurements VI. If you use
C function calls, perform an FFT on the array of data and find the RMS
amplitude of the fundamental harmonic.

14
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12. Compare this RMS value to the limits (V) in Table 3. You will use this
value as x in Table 4.

Table 3. Al Gain Accuracy Limits

Calibrator Output Device Input Amplitude
Amplitude Frequency Min Max
(Vims) (Hz) (Vims) (Vims)
5 1000 4.943 5.058

13. Repeat steps 1 through 12 for all remaining analog input channels of

the device. Replace ai0 with the appropriate channel name in function
call parameters physicalChannel and channel.

Al Flatness Verification
Complete the following steps to verify Al flatness:

1.

Connect the output of the calibrator to the analog input channel O of the
device.

Program the calibrator amplitude and frequency as listed in Table 4.

Repeat steps 3 through 11 of the Al Gain Accuracy Verification section
and compare the RMS value to the limits (V) in Table 4. The minimum
and maximum values are the fractions multiplied by the corresponding
measured value, x, you determined in the Al Gain Accuracy
Verification section.

Repeat steps 2 and 3 of this section for each row in Table 4.

Table 4. Al Flatness Limits

Calibrator Output Device Input Amplitude
Amplitude Frequency Min Max
(Vims) (Hz) (Vims) (Vims)
5 20 0.99655 * x 1.00346 * x
5 2,000 0.99655 * x 1.00346 * x
5 20,000 0.99655 * x 1.00346 * x
5 45,000 0.98855 * x 1.01158 * x

5. Repeat steps 1 through 4 for all remaining analog input channels of the
device. Replace ai0 with the appropriate channel name in function

call parameters physicalChannel and channel.

© National Instruments Corporation
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Timebase Frequency Accuracy Verification

This section describes the verification process for the timebase frequency
accuracy on all the NI 447X devices. All analog inputs use a single circuit
on each device. Therefore, you need to verify only the analog input
frequency accuracy on a single channel to verify this circuit accuracy.

Complete the following steps to verify the timebase:

1. Connect the function generator to the analog input channel O of the
device.

2. Output a sine wave using the function generator. The sine wave should
have an amplitude of 9 V,,, with no DC offset and a frequency of
10 kHz.

3. Ifyouuse LabVIEW, skip this step. If you use C function calls, create
a task using DAQmxCreateTask, as shown below. The task is created
in step 4 in LabVIEW.

LabVIEW Block Diagram NI-DAQmzx Function Call

Call DAQmxCreateTask with the following
LabVIEW does not require this step. parameter:

taskHandle: mytaskHandleReturnvValue

You use the object myTaskHandle in all subsequent NI-DAQmx
function calls.

NI 447X Calibration Procedure 16 ni.com



4. Create an Al voltage channel through NI-DAQmx using the DAQmx
Create Virtual Channel VI, as shown below.

5

Note Refer to the NI-DAQmzx function parameters for the LabVIEW input values.

LabVIEW Block Diagram

NI-DAQmx Function Call

nput kerminal confiquration |

2

imirnum value

kask, ouk
170

Errar ouk

Call DAQmxCreateAIVoltageChan with the
following parameters:

taskHandle: myTaskHandle
physicalChannel: dev1/ai0
nameToAssignToChannel: "
terminalConfig: DAQmx_Val_PseudoDiff

minVal: -10.0

—— Al Voltage v[| |- maxVal: 10.0
I units: DAQmx_Val Volts
CustomScaleName: NULL
5. Modify the Al voltage channel properties using the following
functions.
LabVIEW Block Diagram NI-DAQmzx Function Call
Call DAQmxSetAIGain with the
following parameters:
ask taskHandle: myTaskHandle

i ﬁ =z DA Channel ﬂ

kask.

channel: dev1/ai0

¥ &1.Gain

data: 0.0

¥ A1, Coupling

Errar u:uut|
L- =1

Call DAQmxSetAICoupling with the

following parameters:
taskHandle: myTaskHandle
channel: devl/ai0

data: DAQmx_val_DC

© National Instruments Corporation

NI 447X Calibration Procedure




6. Configure the timing properties of the acquisition using the DAQmx
Timing VI, as shown below.

LabVIEW Block Diagram

NI-DAQmx Function Call

Eamples per channel

kask ouk

Sample Clock =

[ -

Is0

Error ouk

Call DAQmxCfgSampClkTiming
with the following parameters:

taskHandle: myTaskHandle
source: NULL

rate: 40000.0

activeEdge: DAQmx_val_Rising

sampleMode:
DAQmx_Val_FiniteSamps

sampsPerChanToAcquire:
2560000

7. Start the task using the DAQmx Start Task VI, as shown below.

LabVIEW Block Diagram

NI-DAQmx Function Call

ask.in
I/

kask ouk

/0

errar out

Call pAQmxStartTask with the following
parameters:

taskHandle: myTaskHandle

NI 447X Calibration Procedure
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8. If you use LabVIEW, acquire data using the DAQmx Read VI, as
shown below. The acquisition takes over 1 minute. If you use C
function calls, create an array of double float of size 2560000 that will

be filled with data.

LabVIEW Block Diagram

NI-DAQmx Function Call

ask.in
170

umber of samples per channel|
(528

] t— 10

gl | —

kask ouk

ata
S ]

-

o
moog Win | | Errarou
[DELF 1Chan NSamp

Call DAQmxReadAnalogF64 with
the following parameters:

taskHandle: myTaskHandle
numSampsPerChan: -1
timeout: 100.0

fillMode:
DAQmx_Val_GroupByChannel

arraySizeInSamps: 2560000
reserved: NULL

readArray:
float64ArrayReturnvValue

sampsPerChanRead:

int32PointerReturnvValue

9. Stop the task using the DAQmx Stop Task VI, as shown below.

i/ i/o
- [ |
Error in] {7 Error ouk
:

LabVIEW Block Diagram NI-DAQmx Function Call
w—— Call DAQmxStopTask with the following

parameters:

taskHandle: myTaskHandle

10. Clear the task using the DAQmx Clear Task VI, as shown below.

LabVIEW Block Diagram

NI-DAQmx Function Call

Error out

Call DAQmxClearTask with the following
parameters:

taskHandle: myTaskHandle

© National Instruments Corporation 19
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11. If you use LabVIEW, use the Analog 1D Wfm 1chan Nsamp

polymorphic VI to acquire data in step 8. Measure the exact frequency
of the peak around 10 kHz using the Extract Single Tone Information
VI with the following inputs:

¢ advanced search»approx freq.: 10000
* advanced search»search: 1
e export signals: 0 (none)

If you use C function calls, perform an FFT on the array of data.

12. Compare the detected frequency to the limits in Table 5.

Table 5. Timebase Frequency Accuracy Limits

Function Generator Output Device Input Frequency
Amplitude (V) Frequency (Hz) Min (Hz) Max (Hz)
9.0 10,000.00 9,999.75 10,000.25

Adjustment Procedure

The NI 447X adjustment procedure adjusts the analog input calibration
constants. At the end of each adjustment procedure, the new constants are
stored in the external calibration area of the device EEPROM, which
ensures that you do not accidentally access or modify any calibration
constants adjusted by the metrology laboratory while performing a
self-calibration procedure.

NI 447X Calibration Procedure

Analog Input Adjustment

Complete the following steps to adjust the analog input:

L.

Connect the output of the calibrator to all the analog input channels of
the device, using the BNC T-connectors to split the signal in a tree
formation to all the inputs.

Use the calibrator to output 5.00 VDC.
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3. Initialize the Al calibration using the DAQmx Initialize External
Calibration VI, as shown below.

@ Note Refer to the NI-DAQmzx function parameters for the LabVIEW input values.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxInitExtCal with the following
calhandle aut parameters:

deviceName: devl
- EError auk

L password: NI

calHandle: myCalHandle

You use the object myCalHandle in all subsequent NI-DAQmx
function calls.

4. Perform the Al calibration using the DAQmx Adjust DSA Al
Calibration VI, as shown below. The reference voltage parameter is the
voltage value output by the calibrator.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxAdjustDSAAICal with the

ralhandle out following parameters:

calHandle: myCalHandle

i referenceVoltage: 5.0

© National Instruments Corporation 21 NI 447X Calibration Procedure



5. Finish the Al calibration with the DAQmx Close External Calibration
VI, as shown below. Use the action cancel if there has been any error
during the Al calibration or if you do not want to save the new Al
calibration constants in the device EEPROM. Use the action commit
if you want to save the new Al calibration constants in the device
EEPROM.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCloseExtCal with the following
parameters:

Error ouk

calHandle: myCalHandle
=

action: DAQmx_Val_ Action_ Commit or
DAQmx_Val_Action_Cancel

The device is now calibrated with respect to your external source. After
calibrating the device, verify the analog input operation by repeating the
Verification Procedure section.

Where to Go for Support

NI 447X Calibration Procedure

The National Instruments Web site is your complete resource for technical
support. At ni.com/support you have access to everything from
troubleshooting and application development self-help resources to email
and phone assistance from NI Application Engineers.

A Declaration of Conformity (DoC) is our claim of compliance with the
Council of the European Communities using the manufacturer’s
declaration of conformity. This system affords the user protection for
electronic compatibility (EMC) and product safety. You can obtain the DoC
for your product by visiting ni.com/certification. If your product
supports calibration, you can obtain the calibration certificate for your
product at ni.com/calibration.

National Instruments corporate headquarters is located at

11500 North Mopac Expressway, Austin, Texas, 78759-3504.

National Instruments also has offices located around the world to help
address your support needs. For telephone support in the United States,
create your service request at ni . com/support and follow the calling
instructions or dial 512 795 8248. For telephone support outside the United
States, contact your local branch office:

Australia 1800 300 800, Austria 43 662 457990-0,
Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599,
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Canada 800 433 3488, China 86 21 5050 9800,

Czech Republic 420 224 235 774, Denmark 45 45 76 26 00,

Finland 385 (0) 9 725 72511, France 33 (0) 1 48 14 24 24,

Germany 49 89 7413130, India 91 80 41190000, Israel 972 3 6393737,
Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 02 3451 3400,
Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710,

Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466,

New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60,

Poland 48 22 3390150, Portugal 351 210 311 210, Russia 7 495 783 6851,
Singapore 1800 226 5886, Slovenia 386 3 425 42 00,

South Africa 27 0 11 805 8197, Spain 34 91 640 0085,

Sweden 46 (0) 8 587 895 00, Switzerland 41 56 2005151,

Taiwan 886 02 2377 2222, Thailand 662 278 6777,

Turkey 90 212 279 3031, United Kingdom 44 (0) 1635 523545

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section onni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents. txt file on your CD, or
ni.com/patents.
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